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РАЗРЕШЕНИЕ И ЦВЕТОВАЯ МОДЕЛЬ
Подготовка макета к печати начинается прямо с создания макета в графическом редакторе. Самый 
первый шаг - выбрать правильное разрешение для печати и подходящую цветовую модель.

- 300 dpi (dots per inch, точки на дюйм) - это разрешение, с которым работает большинство печатных 
машин. Если задать разрешение меньше, то картинка рискует получиться на печати размытой, 
особенно если в макете есть мелкие элементы, и исправить это в типографии уже никак не смогут. 
Если разрешение больше, то, скорее всего, это никак не скажется на качестве печати. 

- СМУК - это цветовое пространство, использующееся всеми печатными машинами. Каждый из 
основных его цветов соответсвует одной из красок, используемых печатной машиной: Cyan - голубой, 
Magenta - малиновый, Yellow - желтый, blacK - черный. В силу физики смешения красок СМУК 
включает в себя меньше оттенков, чем используемый дисплеями RGB. Например, в нём нет наиболее 
ярких, неоново-кислотных оттенков, поскольку их невозможно получить из четырёх базовых цветов. 
Если вы с самого начала создаёте файл в СМУК, вы будете выбирать только из цветов, которые может 
воспроизвести печатная машина, и сможете избежать сильного расхождения между картинкой на 
мониторе и готовым изделием. Также следует помнить, что не все цветовые профили СМУК 
одинаковые: некоторые из них созданы для печати газет на тонкой, не способной впитать большое 
количество краски бумаге, включают в себя ещё меньше оттенков. Мы рекомендуем использовать 
профиль Ofset_Glos90_D=1.35-1.35-1.25-1.80_inkLim320_D50v4_iSiS_6004_300614.icm

- RGB - это цветовое пространство, здесь каждый цвет задаётся в виде трёх координат. Смешение 
цвета происходит по аддитивному принципу - если сложить все три основных цвета, то результат 
будет не чёрным, а белым. Поэтому RGB используется в системах, построенных на излучении света, 
что делает её самой распространённой - с ней работают все экраны.
Цветовой оттенок в RGB создаётся смешиванием красного (Red), зелёного (Green) и синего (Blue) 
каналов с разной интенсивностью излучения. Яркость каждого из трёх основных цветов 
закодирована числом от 0 до 255, то есть занимает 256 бит или 32 байта.
Например, RGB (90, 0, 157) соответствует фиолетовому, а RGB (255, 223, 0) — жёлтому.



Если вы создали очень яркое изображение в RGB, 
при переводе в СМУК для печати его цвета потеряют 
свою яркость, поскольку их невозможно 
воспоизвести из четырёх базовых красок печатной 
машины. Самый верный способ избежать этого - 
сразу работать в СМУК. 

Превод из RGB в СМУК

Каждый из этих цветов соответствует 
краске в печатной машине.

Цветовые пространства

Для печати изображений в высоком качестве 
необходимо, чтобы их разрешение было не менее 
300 dpi. Если разрешение меньше, картинка 
получится размытой, и это никак нельзя будет 
исправить. 

СМУКRGB

72 dpi300 dpi



Наиболее подходящий формат для макета полиграфического изделия - это .pdf. Именно с ним всегда 
работают специалисты препресс, делая раскладку на печатный лист. Этот формат одинаково 
сохраняет в себе как векторные, так и растровые элементы без потери качества и даёт гарантию того, 
что все они будут одинаково отображаться на любом компьютере.

Помимо .pdf вы также можете передать макет в типографию в формате графическо  го редактора, в 
котором работаете. Это форматы .ai, .cdr, .indd, .psd. Однако в данном случае есть несколько важных 
нюансов, которые следует учесть: 

1. Шрифты. Все текстовые объекты обязательно нужно перевести в кривые , если вы 
работаете в векторном редакторе, или в смарт-объект, если работаете в растровом. 

2. Встроенные изображения. Если вы работаете в редакторе, позволяющем встроить в макет 
изображение, лежащее в отдельной от него папке (linked objects в Indesign или Illustrator), то 
такие изображения обязательно нужно отправить в типографию вместе с макетом: иначе они 
не будут отображаться в макете.

3. Версия программы. У большинства графических редакторов нет обратной совместимости. 
Это значит, что более старые версии программы будут открывать файлы, созданные в более 
новых версиях, с ошибками, или не откроют вовсе. К счастью, при сохранении файла в более 
новой версии всегда можно выбрать опцию «сделать файл совместимым с версией...». 

ФОРМАТЫ ФАЙЛОВ И СОХРАНЕНИЕ

Также макет можно сохранить и просто как обычное растровое или векторное изображение - в 
форматах .tiff или .eps. Главное - убедитесь, что файл имеет корректный размер и разрешение, и не 
забывайте о вылетах.

- каждая страница /
сторона на отдельной 
странице файла
- размер страницы 
соответствует
размеру изделия 
вместе с вылетами

- шрифты в кривых
- все встроенные
изображения
приложены к макету

- каждая страница /
сторона отдельным 
файлом

Лучше всего: Также можно: Или:



Если вы делаете макет в векторном редакторе, следите за тем, чтобы размер страницы  (CorelDraw) 
или рабочей области (Illustrator) соответствовал обрезному формату изделия.

Неправильно:
Размер листа - А4, сбоку от 
него расположены 9 разных 
макетов визиток

Правильно:
Размер листа соответствует размеру визитки (90х
50), каждая визитка расположена на отдельной 
странице

Неправильно:
большая монтажная область 
произвольного размера, на ней 
расположены 9 разных макетов визиток

Правильно:
каждый из макетов расположен на 
отдельной монтажной области 
соответствующего размера (90х50)

Внутри файла: рабочие области и страницы

В CorelDraw:

В Illustrator:



При помощи контурной резки можно создавать множество полиграфических изделий самой 
нестандартной формы: от наклеек и стикерпаков до магнитов и упаковки. Вы создаёте в макете 
векторный контур, и следуя ему, лезвие плоттера вырезает из бумаги (или картона, или магнитной 
основы) самый разные фигуры.

О чем следует помнить при подготовке к печати фигурного макета?

КОНТУРНАЯ РЕЗКА

Если вы планируете вырезать очень сложное, ажурное изделие - сперва покажите контур менеджерам 
и проконсультируйтесь.

В качестве альтернативы плоттерной резки также существуют вырубные штампы. Они представляют 
собой своего рода формы, которые опускаются на стопку бумаги и в  ырезают из неё множество 
фигурных изделий. Штампы хороши для больших тиражей, а также позволяют избежать некоторых 
недостатков плоттерной резки, описанных в пункте 3.

3. Режущие плоттеры не всемогущи и имеют свои ограничения по возможностям резки. 
Слишком мелкие элементы рискуют не прорезаться, поскольку ножу плоттера не останется 
места для маневров и он надорвет бумагу. При резке очень плотных материалов (картоны, 
магнитная основа) маленькие округлые элементы могут получиться немного бугристыми.

2. Контур для плоттерной резки - это векторная линия. Он не может быть растровым и не 
может быть тоненьким объектом с заливкой: иначе плоттер просто не сможет его распознать 
и использовать.

1. Все правила, касающиеся вылетов и отступов, остаются в силе. Даже на самых маленьких 
наклейках от края реза до значимых элементов дизайна должно оставаться расстояние не 
менее 2-3 мм. Помните, что чем мельче изделие, тем больше может быть заметна погрешность 
при резке.



Общие правила

Другие формы

Стикерпаки

Контур реза:
- векторный
- кривая, а не объект
- замкнутый
- толщина 0,1 мм (сверхтонкий абрис)

Припуски:
- как обычно 2 мм
Для стикерпаков тоже!
Отступы:
- 2-3 мм от края реза

Заливка
Контур

Заливка
Контур

Квадрат или прямоугольник Сложные фигурные контуры

Те же правила касательно 
припусков и отступов. 
НО: если и длина и ширина 
изделия равно 30 мм 
и больше, контур реза 
не нужен.

Те же правила касательно 
припусков и отступов. 
НО: существуют ограничения по 
некоторым наиболее мелким 
элементам. Сложные макеты 
лучше сперва показать 
менеджерам и 
проконсультироваться.

Каждый стикер на нём готовим 
так же, как и отдельные 
наклейки или вырубные 
изделия.
Если в контур реза уходит фон, 
контрастный основе, - делаем 
ему припуски.

Основа для стикерпака - 
обычный листовой макет.

Припуски - 2 мм.
Край реза
Отступы - 3 мм



Вынос за обрезной формат должен быть одинаков 
со всех сторон и составлять для одностраничных 
изделий 2 мм (Например, для стандартной визитки 
90х50 мм размер оригинал-макета должен быть 
94х54 мм). Значимые элементы макета должны 
располагаться не ближе 4 мм к границам формата 
готового изделия. Для многостраничных изданий 
вынос за обрезной формат желательно делать 5 мм.

Не располагайте значимую информацию (текст, 
телефоны, линейки и пр.) ближе 4 мм от линии реза 
или скругления. Гарантированные допуски по резке 
материалов без ламината – 1-1,5 мм, 
с ламинатом – 1,5-2,0 мм.

Не располагайте рамочные элементы ближе 
4-5 мм от линии реза.

Если в макете нет вылетов, то при сдвиге 
лезвие гильотины попадает на белую
часть листа и на готовом изделии остаются 
белые полосы по краям.

Лист формата А4

(210х297 мм)

Лист формата А4

с вылетами 2 мм

(214х301 мм)

Отступы: за их пределами

не стоит размещать

важную информацию

ВЫЛЕТЫ И ОТСТУПЫ

Вылеты - это участки цветного фона или картинок, которые выходят за обрезной 
край изделия. Они должны быть не менее 2 мм с КАЖДОЙ стороны.

Линия реза или обрезной край - соответствует размеру готового изделия.

Отступы от обрезного края - это расстояние от важных элементов макета 
до обрезного края. Должны быть не менее 4 мм с КАЖДОЙ стороны.

210

297

214

301

202

289



Краткие требования к вёрстке
Вылеты - не менее 2 мм с КАЖДОЙ стороны.

Линия реза или обрезной край - соответствует размеру готового изделия.

Отступы от обрезного края - Должны быть не менее 4 мм с КАЖДОЙ стороны.

Отступы под пружину / склейку должны составлять не менее 15 мм 
от обрезного края, важную информацию здесь размещать нельзя.

999998

21
0

Не стоит делать:
Самостоятельно добавлять метки реза

Делать рамку по обрезному краю

Делать рамку по краям листа

Буклеты (лифлеты) в 2 сложения и более
Вылеты - не менее 2 мм с КАЖДОЙ стороны.

Линия реза или обрезной край - соответствует 
размеру готового изделия.

Отступы от обрезного края - Должны быть 
не менее 4 мм с КАЖДОЙ стороны.

Буклет А4, Евробуклет, особые требования к размеру 
сложений. Первая часть размером 99 мм в ширину, 
вторая часть, по-середине - 99 мм и третья часть, 
которая складывается внутрь - 98 мм. Это позволяет 
складывать буклет 2 фальца. Размеры на примере 
даны для лицевого оборота, где самая правая часть - 
лицо всего буклета.

Количество страниц
Скрепление на пружину:   кратное 2

Скрепление на термоклей:   любое

Скрепление на скрепку:   кратное 4



1. Документ не должен содержать цветовую модель RGB.

2. Геометрический размер изображения должен соответствовать размеру печатного оттиска.

3. Сумма красок (Total ink limit) не должна превышать 300%. В противном случае мы осуществим конвертацию вашего макета, 

что может привезти к сильному искажению цветов.

5. Не допускается применение эффектов «Линза», «Интерактивная прозрачность», «Тени», «Текстурные заливки» и т. п. 

Они должны быть переведены в растровое изображение.

6. Внедренные в файл растровые изображения должны быть конвертированы в один растровый объект (без слоев).

7. Вылеты под обрез должны быть не менее 5 мм.

8. Все значимые элементы, находящиеся внутри полосы, должны располагаться на расстоянии не менее 5 мм от обрезного 

формата. При наличии рамок на полосах — расстояние не менее 10 мм от обрезного формата.

9. Процент содержания каждой краски должен быть не менее 5% (Желательно от 7-8%), цветозаполнение 1-4% не гарантируется.

10. Черный текст необходимо покрасить в односоставной черный цвет (c0 m0 y0 k100).

11. Крупные по площади чёрные объекты необходимо покрасить в глубокий чёрный цвет (c40 m30 y20 k100). Запрещается 

окрашивать в составной чёрный мелкий текст и линии.

12. По умолчанию опция Overprint при цифровой печати отключена, поэтому в офстеной печати overprint обязателен.

13. Никогда не используйте опцию Overprint для белых объектов, это может привести к их пропаданию при печати.

14. Градиенты – запечатка градиентов менее 5% не гарантируется, для   избежания полошения рекомендуем добавлять 

в градиенты шум (add noise).

15. Толщина линий должна быть не менее 0,25 pt, минимальная толщина негативных линий (выворотки) 1 pt (листовая и ролевая 

журнальная печать). Не рекомендуется использовать линии с атрибутом Hairline, так как на выводном устройстве они могут 

«пропасть».

16. Если требуется печать дополнительными красками, в том числе металлизированными, такими как серебро и бронза, 

они указываются в макете по шкале PANTONE. Необходимо оговорить использование специальных красок 

с менеджером типографии.

4. Максимальная сумма красок на отдельных элементах фотографий может быть 280-300% — не больше.

ПОДГОТОВКА К ОФСЕТНОЙ ПЕЧАТИ



Что такое OVERPRINT
Оверпринт — наложение одного цветного элемента на другой без создания выворотки в процессе 
электронного монтирования цветного материала на допечатной стадии полиграфического процесса. 
Выворотка - инверсное начертание текста.

Причина, по которой машина идет сложным путем, вместо того, чтобы напечатать одну краску
прямо поверх другой, состоит в том, что используемый ею тонер не плотный, а полупрозрачный. Если 
напечатать один элемент поверх другого без выворотки, краски наложатся друг на друга и смешаются. 
Этот эффект и называется “оверпринт“.

• В Corel Draw: выберите любой объект и зайдите в меню Object -> Overprint Fill ( либо Object -> 
Overprint Stroke, если это обводка). Цвета с оверпринтом имеют значок в нижней части панели.

• В Adobe Illustrator: выберите любой объект и откройте панель Window -> Attributes. На это
панели можно при помощи галочек включать и выключать оверпринт заливки и обводки.
За пределами панели Attributes наличие оверпринтов никак не будет показано в макете.

Макет с использованием оверпринтов будет выглядеть на экране компьютера точно так же, как
и без них. Если вы не будете их специально искать, вы никогда не узнаете об их существовании.

Для этого достаточно включить в настройках просмотра симуляцию оверпринта. После этого ваш 
графический редактор покажет вам, какая получится картинка при печати. Если какие-то
объекты пропадут или резко поменяют свой цвет, значит время искать и отключать оверпринты.
• Для Corel Draw: View -> Simulate Overprints
• Для Adobe Illustrator: View -> Overprint Prieview

Как посмотреть, есть ли в макете оверпринт?

Как отключить оверпринт?

Оверпринт 
выключен

Оверпринт 
включен



Файлы предоставляются c расширением CDR, PDF, 
TIFF, предпочтение слитые растровые файлы без 
прозрачностей и слоев в формате TIFF.

Макет должен быть сделан в размер (без вылетов 
под обрез).

Разрешение для растровых файлов: до 1 м - 300dpi, 
от 1 м до 2 м - 150 dpi, более - 100 dpi и меньше.

Итоговый файл на печать должен весить не более 
500-600 Мб.

Цветовое пространство - CMYK.

Размеры:  По техническому заданию

Разрешение:  300 dpi

Цветовая схема:  CMYK

Сжатие:  LZW

Холст с отпечатанным
изображением

Прозрачность, альфа каналы и пр.:  нет

Все файлы должны поступать в работу в формате TIFF
Требования к файлу:

На основной размер изображения добавляются припуски 
по 40 мм с каждой стороны, необходимые для натяжки 
на торцы и загиб на заднюю часть подрамника.

Самый простой и эффективный способ «наращивания» 
изображения - через Photoshop, командой - «Заливка с учетом 
содержимого» (таким образом было нарощено изображение 
на примере выше и ниже).

ИНТЕРЬЕРНАЯ ПЕЧАТЬ

Краткие требования

Неправильно

Правильно

Картины на холсте

Подрамник

40 мм



УФ-ПЕЧАТЬ

+

• все объекты в векторе

• минимальная толщина линий - 0,19 мм

• УФ-лак располагается на отдельном макете рядом с основным макетом, на основном макете его нет. Цвет у лака - зеленый.

На БЕЛОЙ бумаге:

• все объекты в векторе, под каждым объектом должна быть белая подложка, кроме тех элементов, которые заливаются лаком

• минимальная толщина линий - 0,19 мм

• если картинка растровая, то под ней должна быть белая подложка, повторяющая контур картинки

• лак располагается на отдельном макете рядом с основным макетом, на основном макете его нет.  Цвет у лака - зеленый

• белый цвет обозначается красным, располагаться должен на отдельном макете рядом с основным макетом

• последовательность макетов:

• все белые или черные элементы

• все цветные элементы

• все элементы под лак.

На прозрачном материале чаще всего макеты готовят как 

под белую бумагу, но если нужно, что бы с одной стороны 

не было видно печатных элементов, то делаем рядом 

с основным макетом белую подложку. 

Обязательно уточняйте у менеджера такую возможность.

Максимальный размер нанесения - 900х600 мм.

На ЧЕРНОЙ ИЛИ ЦВЕТНОЙ бумаге:

Файлы для УФ-печати должны поступать в формате CDR (не более 21
версии). Также должно быть превью общего вида макета в JPEG..jpeg

При наличии нескольких видов изделий под УФ-
печать, все макеты располагается на одном листе.

Многостраничность не допускается!

3
2

1
321

Белые
элементы

Цветные
элементы

Лак
Итог

печати

Пример макета, печать на черной бумаге:

КЛУБ
№27

НА МУЗЫКАЛЬНОЙ

КЛУБ
№27

НА МУЗЫКАЛЬНОЙ


